The Sensors BoosterPack™ kit (BOOSTXL-SENSORS) is an easy-to-use plug-in module for adding digital sensors to your LaunchPad™ development kit design. SimpleLink™ microcontroller (MCU) LaunchPad development kit developers can use this BoosterPack plug-in module to start developing sensor applications using the onboard gyroscope, accelerometer, magnetometer, pressure, ambient temperature, humidity, ambient light, and infrared temperature sensors.

Figure 1. BOOSTXL-SENSORS BoosterPack™ Plug-in Module

Contents

1 Getting Started ........................................................................................................... 3
2 Hardware .................................................................................................................. 4
3 Software Examples ................................................................................................... 8
4 Additional Resources ............................................................................................... 19
5 Schematics ................................................................................................................ 25

List of Figures

1 BOOSTXL-SENSORS BoosterPack™ Plug-in Module .................................................. 1
2 BOOSTXL-SENSORS Overview ................................................................................. 4
3 BoosterPack Plug-in Module Pinout ........................................................................... 4
4 Setting up COM Port Configuration for the LaunchPad Development Kit ................. 10
5 Programming Sensor Software With the GUI ......................................................... 10
6 Sensor GUI Layout .................................................................................................. 11
7 GUI Sensor Tile ....................................................................................................... 12
8 GUI Integrated EnergyTrace Measurements ............................................................ 13
9 Board Movement Window ...................................................................................... 14
10 Translation Along the X Axis ................................................................................. 14
11 Translation Along the Y Axis .................................................................................. 14
12 Translation Along the Z Axis .................................................................................. 14
13 Rotation Around the X Axis .................................................................................... 15
14 Rotation Around the Y Axis .................................................................................... 15
List of Tables

1. OPT3001 Pinout ........................................................................................................... 5
2. TMP007 Pinout ........................................................................................................... 5
3. BMI160 Pinout .......................................................................................................... 6
4. BMM150 Pinout .......................................................................................................... 6
5. BME280 Pinout .......................................................................................................... 7
6. Hardware Change Log .............................................................................................. 7
7. Software Examples .................................................................................................... 8
8. IDE Minimum Requirements for MSP-EXP432P401R .................................................. 8
9. IDE Minimum Requirements for MSP-EXP430FR5994 ............................................... 8
10. Source File and Folders .......................................................................................... 9
11. Source Files and Folders ........................................................................................ 17
12. Source Files and Folders ........................................................................................ 18

Trademarks

BoosterPack, LaunchPad, SimpleLink, Code Composer Studio, MSP432, EnergyTrace, MSP430Ware, MSP430, E2E are trademarks of Texas Instruments.
ARM, Keil, µVision are registered trademarks of ARM Ltd.
Bluetooth is a registered trademark of Bluetooth SIG.
IAR Embedded Workbench is a registered trademark of IAR Systems AB.
Bosch is a registered trademark of Robert Bosch LLC.
Wi-Fi is a registered trademark of Wi-Fi Alliance.
All other trademarks are the property of their respective owners.
1 Getting Started

1.1 Introduction

The Sensors BoosterPack kit (BOOSTXL-SENSORS) is an easy-to-use plug-in module for adding digital sensors to the LaunchPad development kit design. SimpleLink MCU LaunchPad development kit developers can use this BoosterPack plug-in module to start developing sensor applications using the onboard gyroscope, accelerometer, magnetometer, pressure, ambient temperature, humidity, ambient light, and infrared temperature sensors. (Only the PCB footprint is provided for the infrared temperature sensor due to TMP007 device end-of-life.)

1.2 Key Features

• Inertial measurement unit (IMU) sensor – accelerometer and gyroscope
• Magnetometer
• Environmental sensor: pressure, ambient temperature, and humidity
• Ambient light sensor
• PCB footprint for the infrared temperature sensor (device not populated due to end-of-life)
• Works with TI LaunchPad development kits

1.3 What’s Included

1.3.1 Kit Contents

• 1x BOOSTXL-SENSORS BoosterPack plug-in module
• 1x quick start guide

1.3.2 Software Examples

• SimpleLink MSP-EXP432P401R LaunchPad development kit + BOOSTXL-SENSORS demos (see Section 3)
  – Raw sensor data output + GUI
  – TI RTOS sensor output + GUI
• MSP-EXP430FR5994 LaunchPad development kit + BOOSTXL-SENSORS demos (see Section 3)
  – TI RTOS sensor output + GUI

1.4 Next Steps: Looking Into the Provided Code

After the EVM features have been explored, the fun can begin. It’s time to open an integrated development environment (IDE) and start looking at the code examples. Section 3 describes the example projects available to make it easy to understand the provided software.
2 Hardware

Figure 2 shows an overview of the BoosterPack plug-in module.

2.1 Hardware Features

2.1.1 BoosterPack Pinout

Figure 3 shows the pinout of the BoosterPack plug-in module.
The Sensors BoosterPack plug-in module adheres to the 40-pin LaunchPad development kit and BoosterPack plug-in module pinout standard. A standard was created to aid compatibility between LaunchPad development kits and BoosterPack plug-in modules across the TI ecosystem.

The 40-pin standard on the BOOSTXL-SENSORS is compatible with the 20-pin standard that is used by other LaunchPad development kits like the MSP-EXP430G2 LaunchPad development kit. This allows for 40-pin BoosterPack plug-in modules to be used with 20-pin LaunchPad development kits.

The BOOSTXL-SENSORS BoosterPack plug-in module has both male and female headers to support stacking on top. You must take careful consideration when stacking other BoosterPack plug-in modules near the Sensors BoosterPack plug-in module as heat, shade, and electromagnetic fields can adversely affect the sensors readings.

More information about compatibility can also be found at www.ti.com/launchpad.

2.1.2 TI OPT3001 Light Sensor

The OPT3001 is a digital ambient light sensor (ALS) that measures the intensity of light as visible by the human eye. Covering the sensor with a finger or shining a flashlight on it changes the output of the OPT3001. The digital output is reported over an I²C- and System Management Bus (SMBus)-compatible, 2-wire serial interface. The reference designator for the OPT3001 is U1. Table 1 lists the pin connections of the OPT3001.

More information on the OPT3001 light sensor can be found at www.ti.com/product/opt3001.

<table>
<thead>
<tr>
<th>BoosterPack Header Connection</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1.9</td>
<td>I²C SCL</td>
</tr>
<tr>
<td>J1.10</td>
<td>I²C SDA</td>
</tr>
<tr>
<td>J2.11</td>
<td>OPT3001 Interrupt</td>
</tr>
</tbody>
</table>

(1) Pin is multiplexed with the I²C communication lines of the TMP007, BMI160, and BME280.

Table 1. OPT3001 Pinout

2.1.3 TI TMP007 Temperature Sensor

The TMP007 is a digital infrared (IR) thermopile contactless temperature sensor with integrated math engine that measures the temperature of an object without having to be in direct contact. Placing your hand over the sensor increases the sensor output. The digital output is reported over an I²C- and SMBus-compatible, 2-wire serial interface. The reference designator for the TMP007 is U5. Table 2 lists the pin connections of the TMP007.

NOTE: The TMP007 infrared temperature sensor is no longer populated on this BoosterPack board, and only the PCB footprint is provided due to the end-of-life status of the device.

Table 2. TMP007 Pinout

<table>
<thead>
<tr>
<th>BoosterPack Header Connection</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1.9</td>
<td>I²C SCL</td>
</tr>
<tr>
<td>J1.10</td>
<td>I²C SDA</td>
</tr>
<tr>
<td>J2.12</td>
<td>TMP007 Interrupt</td>
</tr>
</tbody>
</table>

(1) Pin is multiplexed with the I²C communication lines of the OPT3001, BMI160, and BME280.
2.1.4 Bosch® BMI160 Inertial Measurement Sensor

The Bosch BMI160 inertial measurement unit is a 6-axis digital accelerometer and gyroscope sensor that measures gravitational forces exerted on the EVM as well as speed of rotation in degrees per second. The BMI160 can synchronize its own accelerometer and gyroscope data as well as with an external device such as a geomagnetic sensor. Rotating the board about its axis increases the gyroscope output of the sensor, and changing the orientation of the board with respect to the earth changes its accelerometer output (for example, with the X arrow toward the earth, the X value of the accelerometer is positive). The BMI160 has a secondary I²C interface for connecting additional Bosch sensors such as the BMM150 geomagnetic sensor. The digital output of both sensors is reported over an I²C- and SMBus-compatible 2-wire serial interface. The reference designator for the BMI160 is U3. Table 3 lists the pin connections of the BMI160.

More information on the BMI160 inertial measurement unit can be found at www.bosch-sensortec.com/en/bst/products/all_products/bmi160.

<table>
<thead>
<tr>
<th>BoosterPack Header Connection</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1.5</td>
<td>BMI160 Interrupt 1</td>
</tr>
<tr>
<td>J1.9 (1)</td>
<td>I²C SCL</td>
</tr>
<tr>
<td>J1.10 (1)</td>
<td>I²C SDA</td>
</tr>
<tr>
<td>J2.13</td>
<td>BMI160 Interrupt 2</td>
</tr>
</tbody>
</table>

(1) Pin is multiplexed with the I²C communication lines of the OPT3001, TMP007, and BME280

2.1.5 Bosch BMM150 Geomagnetic Sensor

The Bosch BMM150 geomagnetic sensor is a 3-axis digital magnetometer sensor that measures the strength of magnetic fields in microtesla for e-compass applications. The BMM150 can be used in combination with the BMI160 for 9-axis sensing. Placing a magnet near the sensor increases the sensor output. The BMM150 is connected to the BMI160 as a secondary I²C device, and all of its sensor data is passed to the BMI160 to be reported out over an I²C- and SMBus-compatible, 2-wire serial interface. The reference designator for the BMM150 is U2. Table 4 lists the pin connections of the BMM150.

More information on the BMM150 geomagnetic sensor can be found at www.bosch-sensortec.com/en/bst/products/all_products/bmm150.

<table>
<thead>
<tr>
<th>BoosterPack Header Connection</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1.8</td>
<td>BMM150 Interrupt</td>
</tr>
</tbody>
</table>
2.1.6 Bosch BME280 Environmental Sensor

The Bosch BME280 integrated environmental unit is a digital pressure, ambient temperature and relative humidity sensor. Changes in the environment surrounding the sensor cause changes in the sensor output. The digital output of the sensor is reported over an I²C- and SMBus-compatible, 2-wire serial interface. The reference designator for the BMI160 is U3. Table 5 lists the pin connections of the BME280.

More information on the BME280 environmental sensor can be found at www.bosch-sensortec.com/en/bst/products/all_products/bme280.

Table 5. BME280 Pinout

<table>
<thead>
<tr>
<th>BoosterPack Header Connection</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1.9(1)</td>
<td>I²C SCL</td>
</tr>
<tr>
<td>J1.10(1)</td>
<td>I²C SDA</td>
</tr>
</tbody>
</table>

(1) Pin is multiplexed with the I²C communication lines of the OPT3001, TMP007, and BMI60.

2.2 Power

The board was designed to be powered by the attached LaunchPad development kit.

2.2.1 LaunchPad Development Kit Default Power

This is the default power configuration for the BOOSTXL-SENSORS. In this configuration, power is provided through the 3V3 (J1.1) pin on the BoosterPack plug-in module headers. The 3V3 pin powers everything on the Sensors BoosterPack plug-in module.

2.3 Design Files

2.3.1 Hardware

Schematics can be found in Section 5. All design files including schematics, layout, bill of materials (BOM), Gerber files, and documentation are available on the BOOSTXL-SENSORS Hardware Design Files on the download page.

2.3.2 Software

All design files including TI-TXT object-code firmware images, software example projects, and documentation are available in the software folders that are specific to each LaunchPad development kit. To see which LaunchPad development kits feature BOOSTXL-SENSORS examples, visit the download page.

2.3.3 Quick Start Guide

A quick start guide is available for download.

2.4 Hardware Change Log

Table 6 lists the hardware revision history.

Table 6. Hardware Change Log

<table>
<thead>
<tr>
<th>PCB Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rev 1.0</td>
<td>Initial release</td>
</tr>
<tr>
<td>Rev 1.1</td>
<td>Updates for CE</td>
</tr>
</tbody>
</table>
3 Software Examples

The following software examples are included with the SimpleLink MSP-EXP432P401R and MSPEXP430FR5994 LaunchPad development kits for the Sensors BoosterPack plug-in module (see Table 7). These examples can be found in the MSP-EXP432P401R Software Examples and MSP-EXP430FR5994 Software Examples zip folders.

Table 7. Software Examples

<table>
<thead>
<tr>
<th>Demo Name</th>
<th>LaunchPad / BoosterPack Required</th>
<th>Description</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOSTXL-SENSORS_SensorGUI_</td>
<td>MSP-EXP432P401R / BOOSTXL-SENSORS</td>
<td>Demonstrates how to sample data from the five onboard digital sensors and communicate that over UART in a JSON payload</td>
<td>Section 3.1</td>
</tr>
<tr>
<td>MSP432P401R</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BOOSTXL-SENSORS_TI-RTOS_</td>
<td>MSP-EXP432P401R / BOOSTXL-SENSORS</td>
<td>Demonstrates how to sample data from the five onboard digital sensors and communicate that over UART in a JSON payload</td>
<td>Section 3.2</td>
</tr>
<tr>
<td>SensorGUI_MSP432P401R</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BOOSTXL-SENSORS_TI-RTOS_</td>
<td>MSP-EXP430FR5994 / BOOSTXL-SENSORS</td>
<td>Demonstrates how to sample data from the five onboard digital sensors and communicate that over UART in a JSON payload</td>
<td>Section 3.3</td>
</tr>
<tr>
<td>SensorGUI_MSP430FR5994</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To use any of the software examples with the LaunchPad development kit, you must have an integrated development environment (IDE) that supports the MSP432P401R and MSP430FR5994 devices (see Table 8).

Table 8. IDE Minimum Requirements for MSP-EXP432P401R

<table>
<thead>
<tr>
<th>Code Composer Studio™ IDE</th>
<th>IAR Embedded Workbench® for ARM IDE</th>
<th>ARM® Keil® µVision® IDE</th>
</tr>
</thead>
<tbody>
<tr>
<td>v7.1.0</td>
<td>v7.80.3</td>
<td>MDK-ARM v5</td>
</tr>
</tbody>
</table>

Table 9. IDE Minimum Requirements for MSP-EXP430FR5994

<table>
<thead>
<tr>
<th>Code Composer Studio™ IDE</th>
<th>IAR Embedded Workbench® for ARM IDE</th>
</tr>
</thead>
<tbody>
<tr>
<td>v6.1.3</td>
<td>v6.30</td>
</tr>
</tbody>
</table>

For more details on how to get started quickly, and where to download the latest CCS, IAR, and Keil IDEs, see Section 4.
3.1 **BOOSTXL-SENSORS_SensorGUI_MSP432P401R**

This section describes the functionality and structure of the BOOSTXL-SENSORS_SensorGUI_MSP432P401R demo that is included in the MSP-EXP432P401R Software Examples, or more easily accessible through the SimpleLink MSP432™ SDK (see Section 4.6).

### 3.1.1 Source File Structure

The project is split into multiple files (see Table 10). This makes it easier to navigate and reuse parts of it for other projects.

#### Table 10. Source File and Folders

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>msp432_startup_ccs.c</td>
<td>SimpleLink MSP432 MCU family interrupt vector table for CGT</td>
</tr>
<tr>
<td>Library: driverlib</td>
<td>Device driver library (MSP432DRIVERLIB)</td>
</tr>
<tr>
<td>src/bme280.c</td>
<td>Driver for communicating with the environmental sensor</td>
</tr>
<tr>
<td>src/bme280_support.c</td>
<td>Support driver for communicating with the environmental sensor</td>
</tr>
<tr>
<td>src/bmi160.c</td>
<td>Driver for communicating with the IMU and magnetometer sensors</td>
</tr>
<tr>
<td>src/bmi160_support.c</td>
<td>Support driver for communicating with the IMU and magnetometer sensors</td>
</tr>
<tr>
<td>src/demo_sysctl.c</td>
<td>Delay function for MSP432 MCU</td>
</tr>
<tr>
<td>src/i2c_driver.c</td>
<td>Driver for I²C communication with the sensors</td>
</tr>
<tr>
<td>src/main.c</td>
<td>The main function of the demo, interrupt service routines, global variables, and more</td>
</tr>
<tr>
<td>src/opt3001.c</td>
<td>Driver for communicating with the ambient light sensor</td>
</tr>
<tr>
<td>src/tmp007.c</td>
<td>Driver for communicating with the infrared temperature sensor</td>
</tr>
<tr>
<td>src/uart_driver.c</td>
<td>Driver for UART communication with the PC GUI</td>
</tr>
</tbody>
</table>

3.1.2 Working With the GUI

The Sensor GUI allows for quick visualizations of the sensors data and testing of applications.

#### 3.1.2.1 Getting Started

1. Download the BOOSTXL-SENSORS_GUI+ET zip file, and extract its contents.
2. Launch BOOSTXL-SENSORS_GUI+ET.
3. Plug your MSP432P401R LaunchPad development kit with Sensors BoosterPack plug-in module into a USB port. And click the icon in the lower left corner of the GUI.
   - If needed, go to "Options" and select the proper COM Port for the Application UART and the baud rate as 115200 (see Figure 4).

**NOTE:** For Windows, you can find the port number by opening Device Manager and looking for "XDS110 Class Application/User UART" under "Ports (COM & LPT)". It will be listed as COMnn, where nn is the number of the port.
4. Click "File" and click "Program Device". The firmware should download to the LaunchPad development kit (see Figure 5).

5. You should now be seeing live sensor data from the LaunchPad development kit plus the BoosterPack plug-in module.
3.1.2.2 **Understanding the GUI**

Figure 6 shows the layout of the sensor GUI.

![Figure 6. Sensor GUI Layout](image)

The GUI contains six main elements:
1. Four sensor tiles
2. A serial monitor
3. The EnergyTrace™ software section
4. The board movement detection window
5. A menu bar
6. A status bar

The Serial Monitor lets you see the JSON (1) that is being reported back by the MCU.

The menu bar serves two functions:
- To change the serial port settings, click ![Options](image) and then click ![Serial Port...](image). In the dialog, select a port number and the baud rate, which should be 115200. To apply the settings, click "Configure".
- To program the GUI firmware to the MSP432 MCU LaunchPad development kit, click "File" and then click "Program Device...".

The status bar indicates if the LaunchPad development kit is connected to the PC, the port that is used, and the baud rate.

The following example indicates a connection to COM22 at 115000 baud:

![COM22:115200 Hardware Connected.](image)

Click ![to disconnect the GUI](image) to disconnect the GUI:

![Hardware Not Connected.](image)

The following example indicates a busy port on COM22:

![COM22 could not be opened: Error: Opening \C:\COM22: Access denied](image)

To connect the LaunchPad development kit to this COM port, close any programs that are using that port, disconnect the GUI by clicking ![disconnect](image), disconnect and reconnect (or restart) the LaunchPad development kit, and reconnect the GUI.

---

(1) JSON = JavaScript Object Notation. This is the data format in which the information is sent. For more information, go to [www.json.org](http://www.json.org).
3.1.2.3 Sensor Tiles

Four sensor tiles are available in the Sensor GUI for the BOOSTXL-SENSORS BoosterPack plug-in module (see Figure 7). Each tile represents the data output for a sensor or set of integrated sensors. The following is a brief description of each sensor tile:

The OPT3001 Ambient Light Sensor tile responds to ambient light, and displays the brightness of the light in lux. Casting a shadow over this sensor causes the reading to decrease, and shining a light on the sensor cause the reading to increase.

The TMP007 IR Temperature Sensor tile responds to infrared energy emitted by objects in its field of view, displaying this in degrees Celsius. Holding a warm or cold object over the sensor causes a response, even over short distances.

The BME280 Ambient Temperature, Relative Humidity, and Atmospheric Pressure Sensor tile responds to atmospheric pressure in millimeters of mercury (which can be stimulated using a pressure chamber or by lightly pressing on the sensor), relative humidity as a percentage, and ambient temperature in degrees Celsius (both of which can be stimulated by breathing on the sensor).

The IMU tile is made up of two subtiles:

- The BMI160 Accelerometer and Gyroscope tile responds to acceleration in g (which can be stimulated by changing the orientation of the board with respect to Earth's gravity, by shaking, or by changing speed along an axis) and rotation in degrees per second (which can be stimulated by rotating the board about its axes).
- The BMM150 Magnetometer tile responds to magnetic field in microtesla. This sensor can be stimulated by changing the sensor orientation with respect to Earth's geomagnetic field or by passing a magnet over it.

Figure 7. GUI Sensor Tile

The sensor tiles all share a common set of features. With a special case being the IMU (which consists of the BMM150 and BMI160).

1. The sensor part number
2. A hint button. Click 🎥 for an animated demonstration on how to stimulate the sensors. Click again to hide the hint.
3. A graphical and numerical read out of the sensor values.
4. A sample rate selection drop-down menu. Click 2Hz to select another frequency. This is the frequency at which the sensor is checked, which also affects the rate at which the MCU wakes from LPM0.
5. A button to toggle the sensor on and off. Click ON/OFF to toggle the sensor on or off. The current draw of each sensor's "ON" and "OFF" states can be seen in the table described in Section 3.1.2.4, or in the EnergyTrace software hint.
The IMU tile is different from the other tiles in the following ways:

- It is made up of two parts, the BMI160 and the BMM150, each in its own box.
- Each box consists of graphs and numerical data, which are color coded to correspond to one another.
- Each part has its own sample rate selector.
- It has a hint button for each type of sensor; the accelerometer, gyroscope, and magnetometer.

The accelerometer has a display for the acceleration vector magnitude. 1.231

The ON/OFF toggle button puts the BMM150 into hibernate and the BMI160 into pedometer mode, and only the accelerometer remains active.

### 3.1.2.4 EnergyTrace™ Software Function

Figure 8 shows the interface to EnergyTrace technology functions.

![Figure 8: GUI Integrated EnergyTrace Measurements](image)

This section provides monitoring of system current using TI's EnergyTrace technology. It consists of:

1. A hint button. Explains EnergyTrace software measurements and displays a table of expected sensor currents.
2. A start button. Press this to shift any previous data down to the next time frame, clear the graph, and begin the next measurement for the selected duration.
3. An input box. To set the duration in milliseconds, click the arrows or type a value:
4. The past three sensor settings and current measurements, with the most recent on top.
5. A graph showing the actual current draw over time. The X-axis corresponds to 0.5-ms ticks, the Y-axis to the current in milliamps. Each peak is a good indicator of when the MCU is in active mode, and the valleys indicate when the MCU is in LPM0.

This implementation is an abbreviated form of EnergyTrace software. The full version can track power consumption, power mode, and more. EnergyTrace software can be used on any application through Code Composer Studio IDE v6 or IAR Embedded Workbench. For more information, visit [www.ti.com/tool/energytrace](http://www.ti.com/tool/energytrace).
3.1.2.5 **Board Movement Window**

Figure 9 shows the board movement section. When the "motion detection" toggle box is checked, it responds to 10 motions (see Figure 10 through Figure 16):

- Translation along the X, Y, or Z axis
- Positive or negative rotation around the X, Y, or Z axis
- No movement
Figure 13. Rotation Around the X Axis

Figure 14. Rotation Around the Y Axis
Figure 15. Rotation Around the Z Axis

Figure 16. No Movement
With both the OPT3001 tile on and the Light Sensing toggle box checked, the image darkens, whether or not gesture recognition is enabled (see Figure 17).

![Board Movement](image)

Figure 17. Light Sensing in the Gesture Recognition Window

Board movement data is updated whenever the BMI160 is sampled; that is, it follows the same frequency as the BMI160 drop-down selection box. If motion detection is not enabled, no related calculations are done on the microcontroller and hence no update occurs. Similarly, light sensing data is updated whenever the OPT3001 is sampled.

3.2 **BOOSTXL-SENSORS_TI-RTOS_SensorGUI_MSP432P401R**

This section describes the functionality structure of the BOOSTXL-SENSORS_TI-RTOS_SensorGUI_MSP432P401R demo that is included in the MSP-EXP432P401R Software Examples download, or more easily accessible through the SimpleLink MSP432 SDK (see Section 4.6).

This example requires TI-RTOS MSP43x version 2_16_01_14 to be installed in CCS.

More information on the use of TI-RTOS can be found within the TI-RTOS User’s Guide.

### 3.2.1 Source File Structure

Table 11 lists the source files and folders.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS: TI-RTOS</td>
<td>Real-Time Operating System using TI-RTOS Kernel</td>
</tr>
<tr>
<td>Library: driverlib</td>
<td>Device driver library (MSP432DRIVERLIB)</td>
</tr>
<tr>
<td>bmi280.c</td>
<td>Driver for communicating with the environmental sensor</td>
</tr>
<tr>
<td>bmi280_support.c</td>
<td>Support driver for communicating with the environmental sensor</td>
</tr>
<tr>
<td>bmi160.c</td>
<td>Driver for communicating with the IMU and magnetometer sensors</td>
</tr>
<tr>
<td>bmi160_support.c</td>
<td>Support driver for communicating with the IMU and magnetometer sensors</td>
</tr>
<tr>
<td>MSP_EXP432P401R.c</td>
<td>Driver for setting up board specific items (for example, I2C and UART)</td>
</tr>
<tr>
<td>main.c</td>
<td>The demo's main function, tasks, semaphores, global variables, and others</td>
</tr>
<tr>
<td>opt3001.c</td>
<td>Driver for communicating with the ambient light sensor</td>
</tr>
<tr>
<td>tmp007.c</td>
<td>Driver for communicating with the infrared temperature sensor</td>
</tr>
</tbody>
</table>
3.2.2 Working With the GUI

Collaboration with the Sensor GUI is identical to Section 3.1.2, except for programming the device directly from the GUI. The .out file located within the GUI is specific to the BOOSTXL-SENSORS_SensorGUI_MSP432P401R example project. To download the program, you must use a separate IDE, such as CCS or IAR, and the BOOSTXL-SENSORS_TI_RTOS_SensorGUI_MSP432P401R source code found within MSP-EXP432P401R Software Examples.

3.3 BOOSTXL-SENSORS_TI-RTOS_SensorGUI_MSP430FR5994

This section describes the functionality structure of the BOOSTXL-SENSORS_TI_RTOS_SensorGUI_MSP430FR5994 demo that is included in the MSP-EXP430FR5994 Software Examples download, or more easily accessible through MSP430Ware™ software (see Section 4.6).

3.3.1 Source File Structure

Table 12 lists the source files and folders.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library: driverlib</td>
<td>Device driver library (MSP432DRIVERLIB)</td>
</tr>
<tr>
<td>src/bme280.c</td>
<td>Driver for communicating with the environmental sensor</td>
</tr>
<tr>
<td>src/bme280_support.c</td>
<td>Support driver for communicating with the environmental sensor</td>
</tr>
<tr>
<td>src/bmi160.c</td>
<td>Driver for communicating with the IMU and magnetometer sensors</td>
</tr>
<tr>
<td>src/bmi160_support.c</td>
<td>Support driver for communicating with the IMU and magnetometer sensors</td>
</tr>
<tr>
<td>src/demo_sysctl.c</td>
<td>Provides a small delay</td>
</tr>
<tr>
<td>src/i2c_driver.c</td>
<td>Driver for PC communication with the sensors</td>
</tr>
<tr>
<td>src/main.c</td>
<td>The demo’s main function, interrupt service routines, global variables, and others</td>
</tr>
<tr>
<td>src/opt3001.c</td>
<td>Driver for communicating with the ambient light sensor</td>
</tr>
<tr>
<td>src/tmp007.c</td>
<td>Driver for communicating with the infrared temperature sensor</td>
</tr>
<tr>
<td>src/uart_driver.c</td>
<td>Driver for UART communication with the PC GUI</td>
</tr>
</tbody>
</table>

3.3.2 Working With the GUI

Collaboration with the Sensor GUI is identical to Section 3.1.2, except for programming the device directly from the GUI. The .out file located within the GUI is specific to the BOOSTXL-SENSORS_SensorGUI_MSP432P401R example project. To download the program, you must use a separate IDE, such as CCS or IAR, and the BOOSTXL-SENSORS_SensorGUI_MSP430FR5994 source code found in MSP-EXP430FR5994 Software Examples.
4 Additional Resources

4.1 TI LaunchPad Development Kit Portal
More information about LaunchPad development kits, supported BoosterPack plug-in modules, and available resources can be found at:
  • TI's LaunchPad portal: Information about all LaunchPad development kits from TI, for all microcontrollers

4.2 TI Cloud Development Tools
TI's Cloud-based software development tools provide instant access to SimpleLink SDK content and a web-based IDE.

4.2.1 TI Resource Explorer Cloud
TI Resource Explorer Cloud provides a web interface for browsing examples, libraries, and documentation found in the SimpleLink SDK without having to download files to the local drive (see Figure 18).

Learn more about TI Resource Explorer Cloud at https://dev.ti.com/.

![Figure 18. TI Resource Explorer Cloud](image-url)
4.2.2 Code Composer Studio Cloud

Code Composer Studio Cloud (CCS Cloud) is a web-based IDE that lets you quickly create, edit, build, and debug applications for the LaunchPad development kit (see Figure 19). No need to download and install large software packages, simply connect the LaunchPad development kit and begin. You can choose to select from a large variety of examples in the SimpleLink MSP432 SDK and Energia or develop your own application. CCS Cloud IDE supports debug features such as execution control, breakpoints and viewing variables.

A full comparison between CCS IDE Cloud and CCS Desktop is available here.

Learn more about Code Composer Studio Cloud IDE at https://dev.ti.com/.

Figure 19. CCS Cloud
4.3 **Code Composer Studio IDE**

Code Composer Studio IDE Desktop is a professional integrated development environment that supports TI's microcontroller and Embedded Processors portfolio. Code Composer Studio IDE comprises a suite of tools used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source code editor, project build environment, debugger, profiler, and many other features.

Learn more about CCS IDE and download it at [www.ti.com/tool/ccstudio](http://www.ti.com/tool/ccstudio).

CCS IDE v6.1 or higher is required. When CCS has been launched, and a workspace directory chosen, use Project->Import Existing CCS Eclipse Project. Direct it to the desired demo's project directory that contains main.c (see Figure 20).

![Figure 20. Directing the Project->Import Function to the Demo Project](image)

Selecting the \CCS subdirectory also works. The CCS-specific files are located there.

When you click OK, CCS should recognize the project and allow import.
The indication that CCS has found it is that the project appears in the Import CCS Eclipse Projects window and has a checkmark to the left of it (see Figure 21).

![Import CCS Eclipse Projects](image)

**Figure 21. When CCS Has Found the Project**

Sometimes the CCS IDE finds the project but does not show a checkmark; this might mean that your workspace already has a project by that name. You can resolve this by renaming or deleting that project. Even if you do not see it in the CCS IDE workspace, be sure to check the workspace directory on the file system.

### 4.4 IAR Embedded Workbench for TI MSP430 MCUs

IAR Embedded Workbench for MSP430™ MCUs is another very powerful integrated development environment that allows you to develop and manage complete embedded application projects. IAR Embedded Workbench integrates the IAR C/C++ Compiler, IAR Assembler, IAR ILINK Linker, editor, project manager, command line build utility, and IAR C-SPY® Debugger.

Learn more about IAR Embedded Workbench for MSP430 and download it at [www.iar.com/](http://www.iar.com/).

IAR 6.10 or higher is required. To open the demo in IAR, click File>Open>Workspace..., and browse to the *.eww workspace file inside the \\IAR subdirectory of the desired demo. All workspace information is contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by clicking Project>Add-Existing-Project....

Although the software examples have all of the code required to run them, IAR users may download and install MSP430Ware software, which contains MSP430 MCU libraries and the TI Resource Explorer. These are already included in a Code Composer Studio IDE installation (unless the user selected otherwise).
4.5 Energia

Energia is a simple, open-source, and community-driven code editor that is based on the Wiring and Arduino framework. Energia provides unmatched ease of use through very high-level APIs that can be used across hardware platforms. Energia is a lightweight IDE that does not have the full feature set of Code Composer Studio IDE or IAR Embedded Workbench IDE. However, Energia is great for anyone who wants to get started very quickly or who does not have significant coding experience.

Learn more about Energia and download it at www.energia.nu.

4.6 SimpleLink MSP432 SDK, MSP430Ware Software, and TI Resource Explorer

The MSP432 device is part of the SimpleLink microcontroller (MCU) platform, which consists of Wi-Fi®, Bluetooth® low energy, Sub-1 GHz, and host MCUs. All share a common, easy-to-use development environment with a single core software development kit (SDK) and rich tool set. A one-time integration of the SimpleLink platform lets you add any combination of devices from the portfolio into your design. The ultimate goal of the SimpleLink platform is to achieve 100 percent code reuse when your design requirements change. For more information, visit www.ti.com/simplelink.

For the MSP430 16-bit MCUs, the MSP430Ware software package is used. MSP430Ware software is a complete collection of libraries and tools. It includes a driver library (driverlib) graphics library (grlib), and many other software tools. MSP430Ware software is optionally included in a Code Composer Studio IDE installation or can be downloaded separately. IAR users must download it separately.

Both the SimpleLink MSP432 SDK and the MSP430Ware software are included in the TI Resource Explorer for easily browsing tools, documents, examples, and more (see Figure 22).

![Figure 22. TI Drivers Software Examples in TI Resource Explorer](image)

Inside TI Resource Explorer, these examples and many more can be found and easily imported into Code Composer Studio IDE with one click.
4.7 The Community

4.7.1 TI E2E™ Online Community

Search the forums at e2e.ti.com. If you cannot find the answer, post a question to the community.

4.7.2 Community at Large

Many online communities focus on the LaunchPad development kit and BoosterPack plug-in module ecosystem; for example, www.43oh.com. You can find additional tools, resources, and support from these communities.
5  Schematics

Figure 23 shows the schematic. Hardware design files can be found in the BOOSTXL-SENSORS Hardware Design Files.
## Revision History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

<table>
<thead>
<tr>
<th>Changes from March 6, 2017 to May 15, 2018</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Added that TMP007 infrared temperature sensor is no longer populated on board at end of Section 1.1, Introduction</td>
<td>3</td>
</tr>
<tr>
<td>• Changed list item to indicate that TMP007 infrared temperature sensor is no longer populated on board in Section 1.2, Key Features</td>
<td>3</td>
</tr>
<tr>
<td>• Added note that the TMP007 infrared temperature sensor is end-of-life and not populated in Section 2.1.3, TI TMP007 Temperature Sensor</td>
<td>5</td>
</tr>
</tbody>
</table>
STANDARD TERMS FOR EVALUATION MODULES

1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.

1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions set forth herein but rather shall be subject to the applicable terms that accompany such Software.

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned, or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production system.

2 Limited Warranty and Related Remedies/Disclaimers:

2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License Agreement.

2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM. User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10) business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day warranty period.

3 Regulatory Notices:

3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software associated with the kit to determine whether to incorporate such items in a finished product and software developers to write software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference. Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

FCC Interference Statement for Class A EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.
FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada

3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:

This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:

1. this device may not cause interference, and
2. this device must accept any interference, including interference that may cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.

Concernant les EVMs avec antennes détachables:

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le manuel d'usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.

3.3 Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lds/it_ja/general/eStore/notice_01.page 日本国内に輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lds/it_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs (which for the avoidance of doubt are stated strictly for convenience and should be verified by User):

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of Japan.
2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to EVMs, or EVMs.
3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.
【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けていないものがあります。技術基準適合証明を受けていないものご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。
なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・インスツルメンツ株式会社
東京都新宿区西新宿6丁目24番1号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lads/ti_ja/general/eStore/notice_02.page

電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。 http://www.tij.co.jp/lads/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):
This is a class A product intended for use in environments other than domestic environments that are connected to a low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information related to, for example, temperatures and voltages.
4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI's recommended specifications and environmental considerations stated in the user guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or property damage. If there are questions concerning performance ratings and specifications, User should contact a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit components may have elevated case temperatures. These components include but are not limited to linear regulators, switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the information in the associated documentation. When working with the EVM, please be aware that the EVM may become very warm.
4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems. User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees, affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or designees.
4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal, state, or local laws and regulations related to User's handling and use of the EVM and, if applicable, User assumes all responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as accurate, complete, reliable, current, or error-free.
6. **Disclaimers:**

6.1 **EXCEPT AS SET FORTH ABOVE,** EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 **EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN,** NOTHING IN THESE TERMS SHALL BE CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. **USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS.** USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES, EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

8. **Limitations on Damages and Liability:**

8.1 **General Limitations.** IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE TERMS OR THE USE OF THE EVMS, REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING, OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS OCCURRED.

8.2 **Specific Limitations.** IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMNITY OR OTHER OBLIGATION ARISING OUT OF OR IN CONNECTION WITH THESE TERMS, EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. **Return Policy:** Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s) will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s), excluding any postage or packaging costs.

10. **Governing Law:** These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas, without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas. Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated
IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated (‘TI’) technical, application or other design advice, services or information, including, but not limited to, reference designs and materials relating to evaluation modules, (collectively, “TI Resources”) are intended to assist designers who are developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you (individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of this Notice.

TI’s provision of TI Resources does not expand or otherwise alter TI’s applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such TI Resources. TI reserves the right to make corrections, enhancements, improvements and other changes to its TI Resources.

You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications (and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you will thoroughly test such applications and the functionality of such TI products as used in such applications. TI has not conducted any testing other than that specifically described in the published documentation for a particular TI Resource.

You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include the TI product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT. AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREBIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI RESOURCES ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

You agree to fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-compliance with the terms and provisions of this Notice.

This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, TI products and services. These include, without limitation, TI’s standard terms for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm), evaluation modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated